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1. Introduction

The main goal of many tree improvement programmes including the one for Sitka
spruce (Picea sitchensis) in Great Britain is to increase growth rate while maintaining
or enhancing wood quality. The wood quality trait of primary interest is usually wood
density. Density is a major determinant of both wood strength and pulp yield, and thus

is important for a wide range of forest products

Sitka spruce is a commercially important tree species in the UK and other parts of
temperate Europe. Sitka spruce grows relatively rapidly in the UK due to the
environmental conditions found here. The trend towards utilisation of younger trees
from fast-growing managed stands increases the proportion of lower density juvenile
wood being harvested and raises the need for consideration of wood density in

selection programmes.

The main objective of the project described here is to compare the density
measurements obtained using the pilodyn pin penetration method and the results of

measuring tree density using computerised tomography (CT scanning).

The secondary objective is to explain how the CT scanning was carried out and the
way in which the complex images were analysed in order to acquire the values for

wood density.



2. Literature review

“There are now over 600,000Ha of Sitka spruce (Picea sitchensis) in the UK,
comprising 28% of the total forested area. There has been much concern that strength
properties are likely to be reduced by any practice encouraging faster growth rate and
shorter rotation, which is likely to produce a larger cone of lower density juvenile
wood (Brazier, 1977; Brazier et al., 1985; Brazier and Mobbs, 1993). Density has
been positively correlated with physical wood properties such as bending strength,
compression and hardness (Haygreen and Bowyer, 1989).” (Mitchell and Denne
1997)

Traditionally, density has been considered to be the simplest single indicator of wood
quality. Wood density is under strong genetic control (Raymond, 1995) and is a trait
of interest for incorporation into tree breeding programmes (King et al., 1988). Thus,
density has been an important factor when selecting trees in tree breeding
programmes. In the UK to date basic density of Sitka spruce in screening for tree
breeding programmes has been indirectly assessed by determining the depth of

penetration of the pin fired from a pilodyn.

Juvenile wood in conifers differs from mature wood in several ways; for example, it
has lower density values, thinner cell walls and shorter trachieds. As the pilodyn
operates by penetration of the outer rings it will only assess the density of the outer
more mature wood, and hence overestimate the density of the whole tree, especially in
older trees (as is the case in this study). In this study the fact that the stand was
unthinned will result in trees with narrow outer rings with a high proportion of

latewood. This results in low pilodyn pin penetration and too high density estimates.

A pilodyn is a hand-held instrument which fires a flat-nosed pin with a fixed force.
The depth of penetration can be read directly from a scale on the top of the
instrument, and has shown to be strongly negatively correlated with wood basic
density at the point of sampling (Crown 1981, Greaves et al., 1996). Pilodyns have
been used (extensively) for rapid, non-destructive assessment of density in tree

breeding programmes for softwoods (Crown, 1981, King et al., 1988).



Although a somewhat unsophisticated method of wood density determination, it is
very popular due to the fact that a non-destructive means of assessing traits is
advantageous when measuring trees within tree breeding programmes. Although
unsophisticated, in some cases a higher level of accuracy is obtained from pilodyn pin
penetration than for more advanced non-destructive timber density determination
methods. A study by Schimleck et al., (1999) showed that for Eucaluptus globulus
the error was + 22 kg m™ when measured using pilodyn pin penetration, whereas
when the density of the samples was determined using near-infrared spectroscopy the

error was + 30 kg m™.

The pilodyn is either fired into the tree at a fixed height or at a height which is
recorded at the same time as the reading is taken of penetration depth of the pin. The
pilodyn data are then used to select trees for inclusion in breeding programmes or
screening of the trees within such a programme. The success of such a technique
relies upon the sampling point being representative of the whole tree. Wood density
at breast height is strongly correlated with whole-tree wood density (Tackle, 1962,
cited by Wang et al., 1999). Although both these studies analysed Pinus contorta,
there is no evidence to suggest that this is not also the case for Picea sitchensis.

Raymond and Macdonald (1997) carried out a study in eucalypts to determine the
optimal sampling height for pilodyn measurements. This study found that the
optimum sampling point changed with age, and increased as the trees grew taller.
This may have been due to the effect of position from the pith. Density is positively
correlated with distance from the pith, and the pilodyn only penetrates the outer
growth rings of the tree. Thus, increasing the height of the sampling point (given the
tapered form of trees) may provide an improved correlation between pilodyn pin
penetration and wood density.

It has been shown that in lodgepole pine (Pinus contorta) pilodyn pin penetration is
strongly and negatively correlated with density at both the individual tree (r = -0.52, P
< 0.0001) and family levels (r = -0.77, P < 0.0001) (Wang et al. 1999). In this study
the relationship between pilodyn pin penetration and density is examined in Sitka
spruce. In this case, due to the small sample size, the relationship will only be able to

be calculated at the individual tree level.



The pilodyn wood tester has been widely used in tree breeding programmes to rank
families for wood density. For species with juvenile wood density that declines from
pith to the bark, such as Douglas-fir (Pseudotsuga menziesii), western hemlock
(Tsuga heteropliylla), some spruces (Picea. spp.) and firs (Abies spp.) (Kennedy
1995), valuable fast-growing, high-density families could be wrongly classified as
fast- growing but low-density by the pilodyn if no adjustment is made for diameter
(Wang et al. 1999). This is a potential problem when ranking families or individual

trees at an early age.

Density varies considerably across the radial diameter of spruce trees. The general
trend is described as a decrease across the juvenile wood from a maximum close to
the pith down to a minimum by rings 10 — 20, followed by a slight increase or

stabilisation throughout the mature wood to the bark (Mitchell and Denne 1997).

A study of 70-year-old Norway spruce (Picea abies) trees in Quebec showed that
wood density declines from pith to bark up to the eighth annual ring, stabilizes until
the fourteenth annual ring, and increases thereafter (Blouin et al. 1994). This suggests
that in cases where seed (individual) trees are being selected for wood density as well
as for form and growth, some relatively low-density trees could be classed as high-

density because the pilodyn method assesses density of only the outer growth rings.

In order to accurately determine the relationship between the density of the cross
sectional area of the tree and pilodyn pin penetration at the same height on the stem it
is important to acquire the density for the whole cross section. In this study the

density was obtained from the images generated by a CT scanner.

CT scanning was used as a method of density determination because it provides a
means of determining the density of the whole cross section of the disk. A study by
Macedo et al., (2002) showed a very high correlation (R? = 0.94) between the density
as calculated from the data provided by a CT scanner and density values achieved
using the gravimetric method.

A CT scanner is a very advanced type of X-ray machine. Instead of sending out a

single X-ray beam, as in ordinary machines, several beams are sent out



simultaneously from different angles. The X-rays from the beams are detected after

they have passed through the entity being scanned and their strength is measured.

Beams that have passed through less dense tissue will be stronger whereas beams that
have passed through more dense tissue will be weaker. A computer can use this
information to work out the relative density of the tissues examined. The computer
processes the results, displaying them as a two-dimensional image on a monitor
(Brant, 2005). When viewing these images (as with other X-ray images), the greater
the luminosity of the image (or area of the image) the higher the density (i.e.
brightness is positively correlated with density)

The technique of CT scanning was developed by the British inventor Sir Godfrey
Hounsfield, who was awarded the Nobel Prize for his work.

The CT scanner is normally used within a medical context. Nonetheless, as CT
scanners are getting more advanced some of the older models are being removed from
hospitals and other medical facilities. These then become available for research in
other fields such as agriculture and forestry.

There has been a considerable commitment in order to develop commercial CT
scanning equipment for the forest products industry. There are now log scanners
scanning (in a commercial environment) using CT scanning techniques. This
approach was first suggested by Grundberg, (1999). The studies first carried out
showed that an X-ray log scanner with two X-ray sources has great potential as a
powerful tool for control of the sawmill process (Oja, 1999). This suggested that such
an X-ray scanner could operate at speeds of 3 m/s. This equates to 180 m/minute,
which means that such a scanner would be more than capable of keeping pace with

the most modern sawing lines.

0Oja’s (2001) study also showed that such a scanner could be used to measure many
important log parameters during scanning. These parameters include the percentage of
heartwood and the green heartwood density. From these measures the bending

stiffness of the centre boards could be predicted. This would have great benefits as it



could lead to production of a high proportion of boards meeting the appropriate stress

grading requirements.

If this technique were to be employed on a large scale in Great Britain, a database of
these values could be assembled for logs arriving from different forest stands. This
information could be used by the Forestry Commission and others to review tree

improvement on a larger scale.

Tsehaye et al., (1995) suggested that trees should be bred for wood stiffness and not
for wood density, especially if machine grading is to be used commercially. This is
due to the fact that machine stress grading is based on the stiffness of the timber. Part
of the reason for this suggestion is that the authors were grading Pinus radiata. When
compared to commercially-important species of the Northern Hemisphere Pinus
radiata had a very low ranking in terms of stiffness (11/11). The correlation between
stiffness and density is lower in Pinus radiata than in the commercially-important
timber producing species of the Northern hemisphere. In the vast majority of cases
wood density is used as a simple indicator of the mechanical properties of timber
because there is a high correlation between mechanical properties of wood and its
density. Density can also be quantified using non-destructive techniques on standing
trees. Nevertheless the point is valid, in that if a database could be created detailing
more complex mechanical properties such as stiffness (due to the this being the basis
by which mechanical stress grading is carried out) this would lead to further
advancements in tree improvement, since selection would be based on the actual

mechanical properties of timber, rather than an indicator of such properties.



3. Materials and methods

3.1 Sampling

The project involved taking pilodyn readings in two unthinned Sitka spruce stands,
owned and managed by the Forestry Commission. The stands were located at
Benmore (Scotland) where wind exposure is low. One of the sample stands (FR3,
NM456261) was on a slope and the other (FR4, NM455263) was on level ground.
The two stands were planted in 1961. Further site details appear in appendix I.

In order to measure the wind exposure at the sites anemometer masts were erected and

were kept in place from July 2002 until September 2003.

After the anemometer masts were removed, pilodyn measurements were taken by
staff from Forest Research’s Northern Research Station on a sample of 18 trees in
each stand. The 18 sample trees came from three crown/dominance classes, (i.e. six
dominant, six codominent and six subdominant trees. Sampling was done by
identifying the first six trees in each crown/dominance class that met Forest
Research’s straightness criteria (Macdonald et al., 2001). The trees were then felled
and an experimental disk was cut from each tree at the point at which the pilodyn
measurement had been taken. The height at which the disk was taken was noted.

The disks were then coded as follows: stand number - tree number - height at which

the disk was taken (m).

E.g. FR3-98-1.34

The compass orientation was also marked on it.



3.2 CT scanning

The disks were kiln dried to a moisture content of around 12% at Forest Research’s

Northern Research Station.

The disks were moved to the Scottish Agricultural College buildings adjacent to the
Northern Research Station. This is where the CT scanner used in the following was

installed.

The moisture content of the disks was measured in both the heartwood and the
sapwood, using an electronic moisture meter. The mean of these two results was then
calculated. This was done just before the disks were scanned (so there would be as
little difference as possible between the moisture content measurements and the
moisture content of the disks at the time of scanning).

The disks were then placed on their edge in a semi-circular cradle (so they would not
roll off the table), with the western orientation was facing to the right when looking at
the disks face on from the front of the scanner. This was done so that when the
images were created by the CT scanner they would be of the correct orientation.

Several disks were placed in each cradle, separated by semi-circular hardboard

dividers. This was so that a separate image would be created for each disk.

The cradles were placed on the table part of the CT scanner. The table moves linearly
through the circular scanning head as images are taken of the sample disks. This was
controlled from a room adjacent to the scanner in order to protect the operator (and
those assisting the operator) from radiation.

Throughout the scanning data sheets were filled in. This was so that we could be sure
that each image corresponded to the correct disk. A spreadsheet displaying the data
from the data sheets can be found in appendix II.



The images produced by scanning were saved in the dicom (.DIC) file format. In
order to analyse the images they had to be converted from the dicom (.DIC) file

format to the bitmap (.BMP) file format. This was done using the program Star 3.2.

Once the images were converted into bitmap form it is possible for the disks to be
analysed for timber density and ring width using the computer program Windendro.
Windendro calculates the ringwidth in mm and expresses density in terms of pixel
values (greyscale). Appendix Il describes the Windendro standard operating

procedure.

Pixel values (greyscale) represent shades of grey within the following limits:

0 =black (dark)
255 = white (light)

These pixel values are converted to density values using the method described below.

Note: Windendro calculates the density values pixel by pixel along “paths” e.g. on
the north path the software would calculate the density within the path progressively
from the furthest point due north from the pith, until it reached the pith (Fig.1).

S
Fig. 1. North and south “paths” (shaded areas), as used by Windendro. Only the
density within these shaded areas is calculated.



3.3 Converting the relative grey scale values for density acquired from the

images into absolute wood density values.

Step 1: Convert from grey scale to density (uncalibrated)

CT images use Hounsfield units. In order to analyse the images the
Hounsfield units are converted into bitmap grey scale. In order to
acquire the uncalibrated density the greyscale values need to be
converted back into Hounsfield units. From these Hounsfield units the
uncalibrated density is calculated using the internal calibration used by

the CT scanner.

In Star 3.2, Hounsfield values between -812 (-300-512) and 212

(-300+512) are converted into greyscale values from 0 to 255.

—812 (H)=0 greyscale
212 (H)=255 greyscale

The Hounsfield units relate to density as follows:

—1000 Hounsfield units =0 kg m™
0 Hounsfield units =1000 kg m™

Equation 1 combines conversion of greyscale to Hounsfield units with
the conversion of Hounsfield units to density.

Equation 1

Greyscalevalue x1.024

+0.188 )x1000
255

Uncalibraied Density{kg m®)= (

10



Step 2: Convert from uncalibrated density to calibrated density using
regression obtained in the CT scanner using 25 samples of West

African hardwoods.

This is done using equation 2.

Equation 2

Calibrated Density (kg m‘3):( Uncalibrated Density x1.04355+0.013 )xlOOO
Step 3: adjust calibrated density for measured moisture content in order

to calculate the density at 0% MC.
Equation 3

First calculate (Gw) the specific gravity based on volume at mean

moisture content M (%) of the disk analysed.

Calibrated Density
(CT
M 1+(M +100)

The density at 0% MC (Do) is calculated using Equation 4.

Equation 4

GM

D =( 1+(0.009G,, x (30— M)) )

11



Density at 0% MC = 1000 Dy

Step 4: Calculate the density of the sample disk at specific moisture
content (MC), e.g. 12%

Equation 5
D, (l+(MC <100
Density at specific moisture content (kg m‘s):( oL+ ) )x1000
1-0.009D, x (30— MC)
Note : The equations above only apply to moisture contents below 30% (i.e.

below fibre saturation point). A study showing further information on
equations 3-5 is Simpson, (1993).

This chart shows the relationship between density determined by CT images
(calculated using the calibration procedure described in section 3.3), with

values obtained by volumetric methods (Gardiner, pers. comm.).

Chart comparing the density of wood through CT scanning and volumetric measurements
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3.4 Analysis

The following analysis of the density data was carried out.

3.4.1 Show the Variation in wood density across the radius of trees at breast height

This was done by plotting all the values for calibrated density (Eg. 2) from pith to
bark, for the north and south paths, for two random samples of trees. One sample was
taken from the data for FR3 the other from the data for FR4.

3.4.2. Relationship between the mean density values for the north and south paths of

the disk (as determined by the CT scanner) and the measurements for pilodyn pin

penetration

This was calculated so that the relationship between the density of the disk and

pilodyn pin penetration could be measured

This was done by calculating the mean for all the values of calibrated density (Eq. 2)
from pith to bark, in the north and south path of all the samples, from both FR3 and
FR4. These mean values were then correlated with the pilodyn data which had been

already collected for the sample trees.

The figure of 23 pixels was calculated as shown below.

Image size = 450mm?
Image length =512 pixels
20mm =~ distance of pilodyn pin penetration

450mm =512 pixels

450 ..
Imm=——mminsize
512

20mm = 512 x 20 pixels =~ 23 pixels
450

D

13



4. Results

4.1 Variation in wood density across the radius of trees at breast height

4.1.1 The variation in wood density across the radius (at breast height), for a single

random sample tree within stand FR3

The density change from bark to pith in the north path (FR3-115-1.12)
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Distance from bark (pixels)

Fig. 3. shows the density change from bark to pith (kg m™), in the north path of tree
FR3-115-1.12
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The density change from bark to pith in the south path (FR3-115-1.12)
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Fig. 4 . shows the density change from bark to pith (kg m™), in the south path of the
same tree.

4.1.2 The variation in wood density across the radius (at breast height) for a single
random sample tree within stand FR4. (FR4-500-1.48)

Fig. 5 . shows the density change from bark to pith (kg m™), in the north path and Fig.
6. shows the density change from bark to pith (kg m™), in the south path of tree FR4-
500-1.48
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4.2 Relationship between the mean density values for the north and south paths of the

disk (as determined by the CT scanner) and the measurements for pilodyn pin

penetration

Fig. 7. shows the in stand FR3 and Fig. 8. the relationship in FRA4.

Relationship between mean density and pilodn pin penetration (stand FR3)
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4.3 Relationship between the mean density values for the outer 20 mm of the disk

and the measurements for pilodyn pin penetration

Fig. 9. shows the relationship in stand FR3 and Fig. 10 the relationship in stand FRA4.

Relationship between the density of the outer 20 mm pixels and pilodyn pin penetration (stand FR3)
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Relationship between the density of the outer 20 mm and pilodyn pin penetration (stand FR4)
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5. Discussion

5.1 CT Scanning

The density determined from CT images and calibrated using the method outlined
shows a very strong correlation with the density of the same samples measured using
the volumetric method. This is consistant with a very strong correlation found by
Macedo et al. (2002).

This shows that CT scanning is a highly accurate as a means of determining wood
density. However, care needs to be taken because although the CT scanner is very
accurate in determining specific gravity (i.e. the relative densities within the material
being scanned), this accuracy can only be maintained when calculating the absolute

density of wood when the correct calibration is used.
As shown in section 4.1 the method proposed is not limited to measuring the average
density of a disk but can also determine the density distribution across a sample

radius. Thus, the heterogeneity of wood density can be quantitatively determined.

5.2 Relationship between density and pilodyn pin penetration

There are many factors affecting the relationship between the mean density values for
a path (e.g. north and south paths) of a disk and pilodyn pin penetration at the same
height in the tree. One factor is that the pilodyn only penetrates the outer growth
rings of the trees. Therefore, due to the fact that for Sitka spruce timber density is not
relatively constant across a radius an analysis of the relationship would probably show

a poor correlation (as was the case in this study).

One of the difficulties when using the Windendro program was that it analysed
density along paths rather than the density of the whole disk. It would be possible
(but not done in this study) to weight the density values for the path by their distance
from the pith and then estimate the density of the disk. Due to the circular shape of
the disk the values for density closer to the pith would represent a smaller proportion
of the total area than those further away. This measurement of density along paths

also lead to problems where defects in the wood are intersected by the paths; this can

19



lead to a false representation of density. On two occasions in this study data had to be
disregarded in cases where the paths crossed large cracks which had developed in the

disks during drying.

Windendro allows the analysis of up to 32 paths. Use of all these paths would give a
very high degree of accuracy in terms of density measurement. A statistical analysis
could be carried out in order to calculate the number of paths required to acquire an

acceptably accurate value for the density of the disk.

In an attempt to improve this relationship between density and pilodyn pin penetration
the mean density of the outer 23 pixels was considered. This is the density of the
timber which the pilodyn actually penetrates and could therefore be regarded as a true
relationship between timber density and pilodyn pin penetration. The coefficient of
determination (R?) was found to be only moderate. The literature suggests that
because the pilodyn only penetrates the outer rings of the tree (the relatively dense
mature wood), pilodyn measurements lead to overestimates in wood density. This
was the case for stand FR3. However, for stand (FR4) the data was less clear cut,
with the pilodyn overestimating and underestimating density in similar numbers of

trees.
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6. Conclusions

The method proposed for determining wood density using a CT scanner is
significantly accurate.

In the Sitka spruce (Picea sitchensis) samples; there is at best only a moderate
correlation between pilodyn pin penetration and wood density.

21



7. References

Blouin D., Beaulieu J., Daoust G., and Poliquin J. (1994). Wood Quality of Norway Spruce grown in
plantations in Quebec. Wood and Fiber Science: Vol. 26, No. 3, pp. 342-353.

Brant, C.J. (2005). CT scan. http://www.netdoctor.co.uk/health_advice/examinations/ctgeneral.htm.

Crown, D.J. (1981). Use of the Pilodyn wood tester for estimating wood density in standing trees —
influence of site and tree age. 7XVII IUFRO World Forestry Conference, Kyoto, Japan, Sept. 1981.

Greaves, B.L., Borralho, N.M.G., Raymond, C.A. and Farrington, A. (1996). Use of a Pilodyn for the
indirect selection of basic density in Eucalyptus nitens. Can. J. For. Res. 26, 1643-1650.

Grundberg S. (1999). An X-ray LogScanner — a tool for control of the sawmill process. Doctoral
Thesis No. 1999: 37. Division of Wood Technology, Luled University of Technology.

Hansen, J. K. and Rouland, H. (1997). Genetic Parameters for Spiral Grain, Stem Form, Pilodyn and
Growth in 13 Years Old Clones of Sitka Spruce (Picea sitchensis (BONG.) CARR.). Silvae
Genetica, 46, 2-3.

King, J.N., Yeh F.C., Heaman, J.C. and Dancik, B.P. (1988). Selection of wood density and diameter
in controlled crosses of coastal Douglas-fir. Silvae Genetica, 37, 152-157.

MacDonald, E., Mochan, S. and Connolly, T. (2001). Protocol for stem straightness assessment in
Sitka spruce. Forestry commission information note, 39, Forestry Commission, Edinburgh.

Macedo, A., Vaz, C.M.P., Pereira, J.C.D., Naime, J.M., Cruvinel, P.E. and Crestana, S. (2002). Wood
Density Determination by X- and Gamma-Ray Tomography. Holzforschung, 56, 535-540.

Mitchell, M.D. and Denne, M. P. (1997). Variation in density of Picea sitchensis in relation to within-
tree trends in tracheid diameter and wall thickness. Forestry, 70, 47-60.

Oja, J. 1999. X-ray Measurements of Properties of Saw Logs. Doctoral Thesis, Division of Wood
Technology, Lulea University of Technology.

Raymond, C.A. and MacDonald, A.C. (1998). Where to shoot your pilodyn: within tree variation in
basic density in plantation Eucalyptus globulus and E. nitens in Tazmania. New Forests, 15, 205-
221.

Schimleck L.R., Michell A.J., Raymond C.A. and Muneri A. (1999). Estimation of basic density of
Eucalyptus globulus using near-infrared spectroscopy. Can. J. For. Res. 29, 194-201.

Simpson, W. T. (1993). Specific gravity, moisture content, and density relationship for wood. Gen.
Tech. Rep. FPL-GTR-76. Madison, WI: U.S. Department of Agriculture, Forest Service, Forest
Products Laboratory.

Tackle, D. (1962). Specific gravity of lodgepole pine in the inter-mountain region. U.S. For. Serv.
Note, 100.

Tsehaye, A., Buchanan, A.H. and Walker, J.C.F. (1995). A Comparison of density and Stiffness for
Predicting Wood Quality. Journal of the Institute of Wood Science, 78, 539-543.

Wang, T., Aitken, N.S., Rosenberg, P., and Carlson, R. (1999). Selection for height growth and

Pilodyn pin penetration in lodgepole pine: effects on growth traits, wood properties, and their
relationships. Can. J. For. Res. 29, 434-445,

22



23



Appendix 1

(Data gathered by Forest Research, contains background information and data for site
FR3 and FR4.)

Sitka spruce (Stands FR1 — FR4, Lochaline and Benmore)

Four unthinned, pure Sitka spruce stands, owned and managed by the Forestry
Commission, with variations in site slope and wind exposure were studied. These
comprised a level stand and a steep stand at Lochaline on the west coast of Scotland,
where wind exposure is high, and a level stand and a steep stand at Benmore, which is
inland, where wind exposure is low (Figures 2.1 — 2.3). Anemometer masts were
erected at Lochaline and Benmore to compare the wind climates over a twelve month
period. The key site and stand characteristics are summarised in Table 2.2, and the
diameter distribution is shown in Figure 2.4.

Findon o
Scots pine,
spacing

experiment ‘
‘ol e il

Benmore
Lochaline Sitka spruce,
Sitka spruce S & sheltered, steep
’ T a

exposed, steep and level sites.

and level sites.

Eskdalemuir
Sitka spruce
spacing

experiments

£

Figure 2.1: Location of Sample Stands in Great Britain
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Figure 2.2: Level and steep Sitka spruce stands (FR1 & FR2) in exposed location
at Lochaline

Figure 2.3: Level and steep Sitka spruce stands (FR4 & FR3) in sheltered
location at Benmore




Table 2.2 Site and Stand Characteristics for Sitka spruce stands (FR1 - FR4)

Lochaline Benmore

FR1 FR2 FR3 FR4
Number of live trees per 1360 1476 1443 17125
hectare
Top Height (m) 26.6 26.9 28.1 24.5
Planting Year 1954 1954 1961 1961
Age at felling 48 48 42 42
General Yield Class 18 18 24 18
Mean dbh (cm) 28.4 26.1lcm| 24.6 22.3
Mean tree volume (m°) 0.69 0.59 0.53 0.38
Average Slope (Degrees) 3 24 23 6
Mean Hourly Wind Speed 7.0 3.3
(m/s)
z N % 1ol ENMMMHMD
:Unﬂnﬂ} | i MHHHH 0 N ODDHHN HHHHUDDH [ _n

Figure 2.4: Diameter distribution in Sitka spruce stands FR1-FR4
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The stem form class of trees in each stand was measured based on the lean of the stem
in the lowest 4m according to the protocol set out in Annex 1. The classes were
determined as follows:

e Stem Form Class 1: Maximum deviation from the vertical in the first 4m of the
stemis <1%

e Stem Form Class 2: Maximum deviation from the vertical in the first 4m of the
stem is from 1% to 2% inclusive

e Stem Form Class 3: Maximum deviation from the vertical in the first 4m of the
stem is >2%

The stem form class distribution for the Sitka spruce stands at Lochaline and Benmore
are shown in Figure 2.5. In both the Lochaline stands about 60% of the trees fell
within the straightest stem form class (Stem Form Class 1). In both the stands at
Benmore, however, the distribution of Stem Form Classes was reversed, with more
than 50% of trees falling within the poorest stem form (Stem Form Class 3). Factors
other than wind loading appear to have had an overriding effect on stem form. It
seems likely that either genetic origin or differences in soil type and stability (or a
combination of both) have resulted in the poorer form of the trees at Benmore. The
Benmore soils were generally very wet with restricted rooting depth, resulting in poor
stability throughout the life of the stand.
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FR1 Stem Form Class Distribution
Sitka Spruce, Lochaline, Level Site

Percentage of Trees

Stem Form Class 1 Stem Form Class 2

Stem Form Class 3

Percentage of Trees

FR2 Stem Form Distribution
Sitka Spruce, Lochaline, Steep Site

Stem Form Class 1 Stem Form Class 2 Stem Form Class 3

FR4 Stem Form Distribution
Sitka Spruce, Benmore, Level Site

Percentage of Trees

Stem Form Class 1 Stem Form Class 2

Stem Form Class 3

Percentage of Trees

FR3 - Stem Form Class Distribution
Sitka Spruce, Benmore, Steep Site

Stem Form Class 1 Stem Form Class 2

Stem Form Class 3

Figure 2.5: Stem form class distribution for stands FR1-FR4

Monitoring of the wind climate at Lochaline (FR1 & FR2) and Benmore (FR3 &
FR4) continued from July 2002 until September 2003. The data collected support the
assessment that wind speeds in the more exposed stands at Lochaline were higher
than those at the sheltered Benmore site, as shown in Figure 2.6 below.
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Figure 2.6: Wind monitoring data for Lochaline and Benmore (Sites FR1/FR2
and FR3/FR4))

Detailed tree characterisation was completed on a sub-sample of trees in each stand,

in accordance with the agreed protocol, i.e. 18 scientific and 16 industrial sample trees
from each stand. This included measuring diameter at breast height, direction of
maximum lean, local slope of the ground, maximum angle of lean in the first 4m,
competition index, crown shape and wood density at breast height (using the Pilodyn
pin penetration method).

The outer shape of each sample tree was assessed, in the direction of maximum
deviation and at right angles to this, using an Impulse Laser rangefinder, as described
in Annex 1. Stem shape can be plotted from the measurements made, and later
compared with the compression wood incidence in individual discs and the three-
dimensional log scans made in industrial evaluation. Orthogonal photographs of each
sample tree were also taken, showing the profile of the lower part of the stem of the
tree that was being assessed. Figure 2.7 shows examples of the type of profile plotted
from the laser data.
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Tree FR2-181 Stem Plot - 90 degrees to max. deviation

Height up tree (m)

Approx.
im

izontal deviation (m)

Figure 2.7: Stem shape profile plotted from laser data and photograph showing the
actual profile of the same tree

Industrial trees were cut into three 3-metre logs plus four discs, in accordance with the
protocol. Discs were cut from the scientific trees approximately each metre up the
stem with extra discs being cut from parts of the tree with bends. The butt ends of the
logs were marked to show compass direction, so that the position of each batten in the
stem, in relation to slope and wind direction, could be described following industrial
processing (Figure 2.8). Sawlogs from all the Sitka spruce stands were transported to
Adam Wilson and Sons sawmill in Troon, for processing and industrial evaluation.
All sample discs were taken to Northern Research Station for analysis of compression
wood content, disc eccentricity wood density, grain angle and growth.

Figure 2.8: Marking of log end to show location of battens
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Appendix 11

Spreadsheet displaying the data from the data sheets - taken during the CT scans

. Length MC | _
Cradle .Posmon Stand | Tree| from [MC Sap Heart- Time of Tap!e
No. |inCradle| Ref. | No. | baseto| wood Scan Position
disc wood
1 1 FR3 192 1.44 12.0 11.6] 17:34:28 -807
1 2 FR3 98 1.34 11.6 11.3] 17:34:36 -991
1 3 FR1 6 1.39 11.5 11.1] 17:34:43 -1073
1 4 FR3 203 1.42 12.0 11.5] 17:34:51 -1151
1 S FR1 123 1.26 13.6 12.5] 17:34:58 -1245
1 6 FR1 202 1.24 12.2 12.2] 17:35:06 -39
1 I FR1 169 1.43 13.8 13.3] 17:35:13 -261
1 8 FR1 74 1.62 14.0 13.5] 17:35:32 -479
1 9 FR3 168 1.27 11.3 11.1] 17:35:39 -531
2 1 FR1 208 1.30 14.2 13.3] 17:45:24 -683
2 2 FR4 521 1.26 12.3 12.7] 17:45:31 -43
2 3 FR3 81 1.27 12.3 12.6] 17:45:39 -621
2 4 FR1 38 1.27 11.8 11.2] 17:45:46 -649
2 S FR4 439 1.17 12.0 12.9] 17:45:54 -727
2 6 FR4 376 1.24 12.0 11.6] 17:46:01 -909
2 I FR1 90 1.42 12.7 11.8] 17:46:09 -1333
2 8 FR1 255 1.31 12.3 12.6] 17:46:26 -181
2 9 FR3 65 1.13 12.5 13.0] 17:46:33 -595
2 10 FR1 157 1.20 12.4 12.1] 17:46:40 -119
3 1 FR1 249 1.37 11.9 11.7] 17:54:49 -331
3 2 FR3 137 1.19 11.8 12.0] 17:54:49 -403
3 3 FR4 553 1.34 11.4 11.8] 17:55:04 -471
3 4 FR4 338 1.24 11.9 11.8] 17:55:11 -551
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Appendix I1.

Key words:
Category:

Title:

Scope:

Method:

WINDENDRO

Standard Operating Procedure

Pixel values, Ring width, Computer analysis, Windendro.
Assessment.

Measurement of pixel values and ring widths using Windendro
software.

This procedure is for determining the pixel values and ring widths of
tree disk images obtained using CT scanning techniques and
analysed using Windendro software.

1. Convert the image file from the original file format into bitmap
file format (.bmp). This is done using Star 3.2.

2. Open the image that needs to be analysed in paint Shop Pro.

3. Colour the area around the disk white.

The simplest way to do this is to create a white circle outline larger
than the disk. Then fill the outer area with the colour white.

(An example is shown on the next page.)

Using the dropper tool ensure that the black area surrounding the
disk is equal to 0 and that the white area around the edge of the
image is equal to 255.

This is done so the Windendro software has a reference point to work
from.

i.e. Windendro will assign the darkest part of the image the pixel

value 0 and the lightest part of the image the pixel value 255.
Therefore, there must be pixels of those values.

4. Save the new image using the following notation:
(Site ID-Tree ID-Disk 1Dw)
(ex.: FR4-500-1.39w)

Disk ID is the height at which the disk was taken from the tree.
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w - notes that white has been added to the image.

5. Save the image file to a folder of the same name.

6. Install the Windendro key into the Parallel port.

7. Open Windendro software (a select source box will then open).

8. Press the “Cancel button” on the select source box (as the sample
was scanned beforehand using the CT scanner).

9. From the top menu of the main view of Windendro, select,
Calibration>Method>Intrinsic and select “Intrinsic (for scanners)”.
Then press OK (the Intrinsic method is the one to be used for
scanned images).

* |ntrinsic [for scanners)
" Object of known dimensions [for cameras]

Cnnmlll (0] 4 |

10. A resoulution box will then open asking for the resolution of the
image (d.p.1.).

This is calculated as follows:

Image size = 450 mm?
Number of pixels =512

450mm = 25.4 =17.72inches
pixels 512
inches 17.72

—28.9d.p.i

11. From the top menu of the main view of Windendro, select,
Path>Creation Parameters and enter the path width and the number
of radii that are needed for the analysis. By default, Windendro uses
a path width of 2.00mm. then press OK.
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Path Creation Parameters A -_.:'- il ll

Path width IE.I]'II i

= 1 Number of radil [8 [1 10 32)

-
F "\‘ ™ Hinrdzapta ] and werfeal diresinn: only
.
ay H:u-
o
Caneel | [ ok ]

12. From the top menu of the main view of Windendro, select,
Path>Identification Preferences, then tick the “path identification”

option and select “text” (this allows the user to name each path one
by one). Then press OK.

Path Identification Preferences o x|

Mame ! <}
Site identification I Text i * = must use

default
ﬂ-

-

#  Tree height | |Resl

v Tree age | [integer =]+  typesior

' Uservarishie | [Real =] amabysls whh

5 Path identification| RN -| o lin
Default Names & Types |

I~ Sapwood width
[~ Bark thickness g
"0 fmage C  Nameriealsalie

Cancel 1 rT‘

13. From the top menu of the main view of Windendro, select
Data>Ring Based Data Files Format and select the option "From
Bark to Pith" in the Order section. Then Press OK'
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Ring Based Data Files Format 0 :: : ﬂ
Ring width is always saved
I Earlywood [mm]

™ Earlywood [9]
WIDTH I Latewood [mm]
I Lalewood [%6]

F Maximum
Minimum
DENSITY | I~ Ring [Mean]

I Earhywoad [Mean]
™ Latewosd [Mean]

MISC. [ Ring Angle

” From Pith to Bark
Ord
“' & From Bark 1o Pith X
[ ¥ not supported by XLSTEM |

[ Onby the last !5 years
Cancel 1 oK I

Steps 1 to 12 need to be done only once at the beginning of the
project’. However, it is necessary to verify the options ticked from
steps 8 to 12 every time you start working with Windendro.

14. Press on the floppy disc icon to acquire the image to be analysed.

15. With the red cross cursor, click the pith centre of the opened
image (an identification box will then open).

16. Fill in the Identification box and write "South” at the Path
identification “Then press OK’ (This is due to Windendro naming the
south path first).

35



1derntificatinm

Tree identification |37

Site identification  [FRS

Tree idg.ht _ !IIE.I]IIIII] m
Year of last riﬁg 3 %2["]4 :

Treeage |ll [0 i unknown

DiskHeight  [19.000 m

Path identification |1

Betings | .{:a.ll:ell: oK

17. Another box will then open asking where to save the data. If it is
the first time you are analysing a disc from the tree being analysed,
press the "Create one™ button. Alternatively, press the "Open one"
button and open the file where you previously saved the information.

g5
Data are ready to be saved. ;

No data file is open,

 would you like to :

Open one Create one ’

Save nothing |

Create a folder named by the site ID, tree ID and the height at which
the disk was taken.

This is due to the fact that Windendro automatically saves the results to
the folder in which the new data file is situated. Therefore, giving the
folder the same name will help to avoid confusion.

18. Fill in the path radii name box. “South” will appear highlighted as
it was input into the “path identification’ box. Delete the word south
and type in north (if using 2 paths) as the program has already named
the south path. Then press OK.

Note: Windendro names the paths in the following order:
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South, North, East, West

19. The ring detection have now been performed by Windendro. To
ensure that Windendro recognised all rings properly, look at each ring
one by one.

if Windendro did not recognise the ring properly), select it with the red
cross cursor (the mark will pass from green to yellow) and delete it
with the

left hand button of the mouse. The ring will then be deleted.
Conversely if Windendro forgot to mark one ring, position the red
cross cursor over the annual growth ring that wasn't recognised and
click on the left button of the mouse. The ring will then be marked. Try
to ensure that all paths have the same number of rings (In an image
with low resolution and a high density of growth rings this can be
difficult).

[The data for ring width has now been saved in the folder created in
part 17. it is now time to set up windendro to calculate the pixel values
for the image]

20. From the main menu of the main view of Windendro select
Data>Pixel Based Data and tick the "save pixel based data" option’
Select the option "Columns” in the Orientation section and the option
"From Pith to Bark™ in the Order section too. Then press OK.

¥ Save pixel based dala
¥V Year
I Slitangle
[~ Teach and show similitude curve
NOTE: Density is always saved

QOrientation

ll

* Colums

s ma————
mmmmar- =
T
e

" From Bark to Pith

Order . From Pith to Bark

Cancel ! 0K

A dialog box will now appear. It tells the user that the new data will
not be saved unless the paths are reactivated. Therefore double click
on all the paths to reactive them and this will mean that the data for
density will be saved.
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21. From the top menu of the main view of Windendro, select
Density>Light Calibration Parameters and tick "None". Then press OK.

22. From the top menu of the main view of Windendro, select
Density>Media Type and choose the "Wood or positive print" option.
Then press OK.

Media Type TR

* Wood or positive print
" Film or negative

Cancel oK

23. From the top menu of the main view of Windendro, select
Data>Close File. This will end the analysis.

24. Close Windendro and open the folder (data file) created in part 17.
Save the original image created in part 4 to this file also (so the data set
is complete).

When the analysis is complete each folder will contain four files:
The image (ex.: FR4-500-1.39w.bmp).

The pixel values (ex.: FR4-500-1.39w.pxb)

The ring width values (ex.: FR4-50-1.39w.txt

The path file (ex.: FR4-500-1.39w.pat)

[N.B. if when opening the pixel value files (.pxb) the computer asks
you to select a program to open the file, choose Microsoft excel]
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Appendix IV

Two Sample images and the corresponding data sets.

FR3-86-1.35
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FR4- 521-1.26
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SOUTHERN PATH

WINDENDRO
SAMPLE
THICKNESS mm
SLITLENGTH mm
SLITWIDTH mm
HPIXELSIZE mm
VPIXELSIZE mm
DATA
DENSITY
132
61
10

29
57
69
65
59
59
61
61
62
67
68
65
62
60
58
57
53
59
76
73
70
71
67
66
66
64
64
63
64
72
72
70
68
64
65
68
68
65
64
66

3 Uncalibrated Calibrated
86 Density

1
2

0.878893
0.878893
0.878893

YEAR

N

2002

2001

2000

1999

1998

1997

1996

1995

1994

1993

1992

1991

1990

1989

1988

1987

1986
1985

0.3044549
0.41689412
0.46508235
0.44901961
0.42492549
0.42492549
0.43295686
0.43295686
0.43697255
0.45705098
0.46106667
0.44901961
0.43697255
0.42894118

0.4209098
0.41689412
0.40083137
0.42492549
0.49319216

0.4811451
0.46909804
0.47311373
0.45705098
0.45303529
0.45303529
0.44500392
0.44500392
0.44098824
0.44500392
0.47712941
0.47712941
0.46909804
0.46106667
0.44500392
0.44901961
0.46106667
0.46106667
0.44901961
0.44500392
0.45303529

Density

0.330714

0.44805
0.498337
0.481574
0.456431
0.456431
0.464812
0.464812
0.469003
0.489956
0.494146
0.481574
0.469003
0.460622

0.45224

0.44805
0.431288
0.456431
0.527671
0.515099
0.502527
0.506718
0.489956
0.485765
0.485765
0.477384
0.477384
0.473193
0.477384
0.510908
0.510908
0.502527
0.494146
0.477384
0.481574
0.494146
0.494146
0.481574
0.477384
0.485765

0.29794
0.403649
0.448952
0.433851
0.411199
0.411199

0.41875

0.41875
0.422525
0.441401
0.445177
0.433851
0.422525
0.414974
0.407424
0.403649
0.388547
0.411199
0.475379
0.464053
0.452727
0.456503
0.441401
0.437626
0.437626
0.430076
0.430076

0.4263
0.430076
0.460278
0.460278
0.452727
0.445177
0.430076
0.433851
0.445177
0.445177
0.433851
0.430076
0.437626

Moisture
Content % 0% MC

11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11

0.283497
0.377586
0.416943
0.403887
0.384185
0.384185
0.390768
0.390768
0.394054
0.410423
0.413685
0.403887
0.394054
0.387479
0.380888
0.377586

0.36434
0.384185
0.439641
0.429936
0.420197
0.423447
0.410423
0.407157
0.407157
0.400613
0.400613
0.397336
0.400613
0.426694
0.426694
0.420197
0.413685
0.400613
0.403887
0.413685
0.413685
0.403887
0.400613
0.407157

Density at Density at
12 MC

0.332384
0.449971
0.500311
0.483535
0.458364
0.458364
0.466755
0.466755

0.47095
0.491923
0.496117
0.483535

0.47095
0.462559
0.454168
0.449971
0.433184
0.458364
0.529661
0.517084
0.504505
0.508698
0.491923
0.487729
0.487729

0.47934

0.47934
0.475145

0.47934
0.512891
0.512891
0.504505
0.496117

0.47934
0.483535
0.496117
0.496117
0.483535

0.47934
0.487729



66
66
59
53
56
52
53
55
49
50
56
55
52
55
58
58
61
61
52
50
62
62
46
36
43
52
45
35
31
29
38
52
48
32
23
20
22
36
54
52
37
26
22
25
28
34
56
69
55
42
37
37
41
53
64

'_\
©
~
~
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0.45303529
0.45303529
0.42492549
0.40083137
0.41287843
0.39681569
0.40083137
0.40886275
0.38476863
0.38878431
0.41287843
0.40886275
0.39681569
0.40886275

0.4209098

0.4209098
0.43295686
0.43295686
0.39681569
0.38878431
0.43697255
0.43697255
0.37272157
0.33256471
0.36067451
0.39681569
0.36870588
0.32854902
0.31248627

0.3044549
0.34059608
0.39681569
0.38075294
0.31650196
0.28036078
0.26831373

0.2763451
0.33256471
0.40484706
0.39681569
0.33658039
0.29240784

0.2763451
0.28839216
0.30043922
0.32453333
0.41287843
0.46508235
0.40886275
0.35665882
0.33658039
0.33658039
0.35264314
0.40083137
0.44500392

0.485765
0.485765
0.456431
0.431288
0.443859
0.427097
0.431288
0.439669
0.414525
0.418716
0.443859
0.439669
0.427097
0.439669

0.45224

0.45224
0.464812
0.464812
0.427097
0.418716
0.469003
0.469003
0.401954
0.360048
0.389382
0.427097
0.397763
0.355857
0.339095
0.330714
0.368429
0.427097
0.410335
0.343286

0.30557
0.292999

0.30138
0.360048
0.435478
0.427097
0.364238
0.318142

0.30138
0.313952
0.326523
0.351667
0.443859
0.498337
0.439669
0.385191
0.364238
0.364238
0.381001
0.431288
0.477384

0.437626
0.437626
0.411199
0.388547
0.399873
0.384772
0.388547
0.396098
0.373446
0.377222
0.399873
0.396098
0.384772
0.396098
0.407424
0.407424

0.41875

0.41875
0.384772
0.377222
0.422525
0.422525

0.36212
0.324367
0.350794
0.384772
0.358345
0.320592
0.305491

0.29794
0.331918
0.384772
0.369671
0.309266
0.275289
0.263963
0.271513
0.324367
0.392323
0.384772
0.328143
0.286615
0.271513
0.282839
0.294165
0.316817
0.399873
0.448952
0.396098
0.347019
0.328143
0.328143
0.343244
0.388547
0.430076

11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11

0.407157
0.407157
0.384185

0.36434
0.374281
0.361018

0.36434
0.370971

0.35103
0.354363
0.374281
0.370971
0.361018
0.370971
0.380888
0.380888
0.390768
0.390768
0.361018
0.354363
0.394054
0.394054
0.341004
0.307321
0.330943
0.361018
0.337655

0.30393
0.290325
0.283497
0.314091
0.361018
0.347692
0.293732
0.262912
0.252563
0.259467
0.307321
0.367658
0.361018
0.310708
0.273224
0.259467
0.269791
0.280077
0.300535
0.374281
0.416943
0.370971

0.32758
0.310708
0.310708
0.324214

0.36434
0.400613

0.487729
0.487729
0.458364
0.433184
0.445775
0.428987
0.433184
0.441578
0.416393
0.420591
0.445775
0.441578
0.428987
0.441578
0.454168
0.454168
0.466755
0.466755
0.428987
0.420591
0.47095
0.47095
0.403798
0.361798
0.3912
0.428987
0.399599
0.357597
0.340789
0.332384
0.3702
0.428987
0.412195
0.344992
0.307164
0.294551
0.30296
0.361798
0.437381
0.428987
0.365999
0.319775
0.30296
0.315572
0.328182
0.353395
0.445775
0.500311
0.441578
0.387001
0.365999
0.365999
0.382801
0.433184
0.47934



55 0
42 0
42 0
43 0
41 0
39 0
46 1972
65 1
70 0
58 0
50 0
48 0
50 0
60 1971
66 0
42 0
42 0
NORTHERN PATH
SAMPLE 86
THICKNESS mm 1
SLITLENGTH mm 2
SLITWIDTH mm 0.878893
HPIXELSIZE mm  0.878893
VPIXELSIZE mm  0.878893
DATA
DENSITY YEAR
0 0
0 0
1 0
3 0
11 0
35 0
62 2002
70 0
69 2001
70 1
70 2000
70 1
70 1999
67 1
64 1998
66 0
68 1997
69 1
74 1996
76 1995
72 0
67 1994

0.40886275
0.35665882
0.35665882
0.36067451
0.35264314
0.34461176
0.37272157
0.44901961
0.46909804

0.4209098
0.38878431
0.38075294
0.38878431
0.42894118
0.45303529
0.35665882
0.35665882

0.43697255
0.46909804
0.46508235
0.46909804
0.46909804
0.46909804
0.46909804
0.45705098
0.44500392
0.45303529
0.46106667
0.46508235
0.48516078
0.49319216
0.47712941
0.45705098
0.44098824

0.439669
0.385191
0.385191
0.389382
0.381001

0.37262
0.401954
0.481574
0.502527

0.45224
0.418716
0.410335
0.418716
0.460622
0.485765
0.385191
0.385191

0.469003
0.502527
0.498337
0.502527
0.502527
0.502527
0.502527
0.489956
0.477384
0.485765
0.494146
0.498337

0.51929
0.527671
0.510908
0.489956
0.473193

0.396098
0.347019
0.347019
0.350794
0.343244
0.335693

0.36212
0.433851
0.452727
0.407424
0.377222
0.369671
0.377222
0.414974
0.437626
0.347019
0.347019

0.422525
0.452727
0.448952
0.452727
0.452727
0.452727
0.452727
0.441401
0.430076
0.437626
0.445177
0.448952
0.467828
0.475379
0.460278
0.441401

0.4263

11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11

11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11

0.370971
0.32758
0.32758

0.330943

0.324214

0.317469

0.341004

0.403887

0.420197

0.380888

0.354363

0.347692

0.354363

0.387479

0.407157
0.32758
0.32758

0.394054
0.420197
0.416943
0.420197
0.420197
0.420197
0.420197
0.410423
0.400613
0.407157
0.413685
0.416943
0.433175
0.439641
0.426694
0.410423
0.397336

0.441578
0.387001
0.387001

0.3912
0.382801

0.3744
0.403798
0.483535
0.504505
0.454168
0.420591
0.412195
0.420591
0.462559
0.487729
0.387001
0.387001

0.47095
0.504505
0.500311
0.504505
0.504505
0.504505
0.504505
0.491923

0.47934
0.487729
0.496117
0.500311
0.521276
0.529661
0.512891
0.491923
0.475145



60
60
62
61
66
62
59
61
61
61
63
63
62
62
56
55
61
66
59
55
56
46
45
53
46
38
49
56
48
50
60
60
59
66
60
50
67
77
57
39
45
53
46
38
33
39
52
50
37
28
22
20
30
53
60

0.42894118
0.42894118
0.43697255
0.43295686
0.45303529
0.43697255
0.42492549
0.43295686
0.43295686
0.43295686
0.44098824
0.44098824
0.43697255
0.43697255
0.41287843
0.40886275
0.43295686
0.45303529
0.42492549
0.40886275
0.41287843
0.37272157
0.36870588
0.40083137
0.37272157
0.34059608
0.38476863
0.41287843
0.38075294
0.38878431
0.42894118
0.42894118
0.42492549
0.45303529
0.42894118
0.38878431
0.45705098
0.49720784
0.41689412
0.34461176
0.36870588
0.40083137
0.37272157
0.34059608
0.32051765
0.34461176
0.39681569
0.38878431
0.33658039
0.30043922

0.2763451
0.26831373
0.30847059
0.40083137
0.42894118

0.460622
0.460622
0.469003
0.464812
0.485765
0.469003
0.456431
0.464812
0.464812
0.464812
0.473193
0.473193
0.469003
0.469003
0.443859
0.439669
0.464812
0.485765
0.456431
0.439669
0.443859
0.401954
0.397763
0.431288
0.401954
0.368429
0.414525
0.443859
0.410335
0.418716
0.460622
0.460622
0.456431
0.485765
0.460622
0.418716
0.489956
0.531861

0.44805

0.37262
0.397763
0.431288
0.401954
0.368429
0.347476

0.37262
0.427097
0.418716
0.364238
0.326523

0.30138
0.292999
0.334904
0.431288
0.460622

0.414974
0.414974
0.422525
0.41875
0.437626
0.422525
0.411199
0.41875
0.41875
0.41875
0.4263
0.4263
0.422525
0.422525
0.399873
0.396098
0.41875
0.437626
0.411199
0.396098
0.399873
0.36212
0.358345
0.388547
0.36212
0.331918
0.373446
0.399873
0.369671
0.377222
0.414974
0.414974
0.411199
0.437626
0.414974
0.377222
0.441401
0.479154
0.403649
0.335693
0.358345
0.388547
0.36212
0.331918
0.313042
0.335693
0.384772
0.377222
0.328143
0.294165
0.271513
0.263963
0.301716
0.388547
0.414974

11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11

0.387479
0.387479
0.394054
0.390768
0.407157
0.394054
0.384185
0.390768
0.390768
0.390768
0.397336
0.397336
0.394054
0.394054
0.374281
0.370971
0.390768
0.407157
0.384185
0.370971
0.374281
0.341004
0.337655

0.36434
0.341004
0.314091

0.35103
0.374281
0.347692
0.354363
0.387479
0.387479
0.384185
0.407157
0.387479
0.354363
0.410423
0.442868
0.377586
0.317469
0.337655

0.36434
0.341004
0.314091
0.297136
0.317469
0.361018
0.354363
0.310708
0.280077
0.259467
0.252563
0.286913

0.36434
0.387479

0.462559
0.462559
0.47095
0.466755
0.487729
0.47095
0.458364
0.466755
0.466755
0.466755
0.475145
0.475145
0.47095
0.47095
0.445775
0.441578
0.466755
0.487729
0.458364
0.441578
0.445775
0.403798
0.399599
0.433184
0.403798
0.3702
0.416393
0.445775
0.412195
0.420591
0.462559
0.462559
0.458364
0.487729
0.462559
0.420591
0.491923
0.533853
0.449971
0.3744
0.399599
0.433184
0.403798
0.3702
0.349193
0.3744
0.428987
0.420591
0.365999
0.328182
0.30296
0.294551
0.336587
0.433184
0.462559



47
34
27
26
26
29
50
76
68
45
36
35
35
48
66
60
43
40
41
38
38
55
71
67
56
50
50
55
63
49
18
18
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0.37673725
0.32453333
0.29642353
0.29240784
0.29240784

0.3044549
0.38878431
0.49319216
0.46106667
0.36870588
0.33256471
0.32854902
0.32854902
0.38075294
0.45303529
0.42894118
0.36067451
0.34862745
0.35264314
0.34059608
0.34059608
0.40886275
0.47311373
0.45705098
0.41287843
0.38878431
0.38878431
0.40886275
0.44098824
0.38476863
0.26028235
0.26028235

0.406144
0.351667
0.322333
0.318142
0.318142
0.330714
0.418716
0.527671
0.494146
0.397763
0.360048
0.355857
0.355857
0.410335
0.485765
0.460622
0.389382

0.37681
0.381001
0.368429
0.368429
0.439669
0.506718
0.489956
0.443859
0.418716
0.418716
0.439669
0.473193
0.414525
0.284618
0.284618

Mean Mean
Uncalibrated Calibrated
Density Density

0.40192825 0.432432

Mean Mean
Uncalibrated Calibrated
Density Density
of the last of the last
23 pixels 23 pixels

0.43732174 0.469367

0.4565272 0.489409

0.44692447 0.479388

0.365896
0.316817
0.29039
0.286615
0.286615
0.29794
0.377222
0.475379
0.445177
0.358345
0.324367
0.320592
0.320592
0.369671
0.437626
0.414974
0.350794
0.339469
0.343244
0.331918
0.331918
0.396098
0.456503
0.441401
0.399873
0.377222
0.377222
0.396098
0.4263
0.373446
0.256412
0.256412

11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11
11

0.34435
0.300535
0.276652
0.273224
0.273224
0.283497
0.354363
0.439641
0.413685
0.337655
0.307321

0.30393

0.30393
0.347692
0.407157
0.387479
0.330943
0.320844
0.324214
0.314091
0.314091
0.370971
0.423447
0.410423
0.374281
0.354363
0.354363
0.370971
0.397336

0.35103
0.245642
0.245642

0.407996
0.353395
0.323979
0.319775
0.319775
0.332384
0.420591
0.529661
0.496117
0.399599
0.361798
0.357597
0.357597
0.412195
0.487729
0.462559

0.3912
0.378601
0.382801

0.3702

0.3702
0.441578
0.508698
0.491923
0.445775
0.420591
0.420591
0.441578
0.475145
0.416393
0.286141
0.286141

Mean Mean
Density at Density at
0% MC 12MC

0.364861 0.434309
Mean Mean
Density at Density at
0% MC  12MC

of the last of the last
23 pixels 23 pixels

0.394176 0.471306

0.409959 0.491374

0.402068 0.48134



Southern Path

WINDENDRO 3

SAMPLE 521

THICKNESS mm 1

SLITLENGTH mm 2

SLITWIDTH mm 0.878893

HPIXELSIZE mm  0.878893

VPIXELSIZE mm  0.878893

DATA

DENSITY YEAR

0 1

2 1

7 1

21 1

65 1

110 1

121 2002

122 0

123 0

108 2001

90 1

84 2000

83 0

79 1999

69 0

61 0

62 1998

59 1

58 1997

64 0

63 0

61 1996

60 1

60 1995

61 1

57 1994

51 1

57 0

65 1993

65 1

63 1992

64 1

68 1991

56 1990

52 1

60 0

48 0

44 1989

62 0

62 0

45 1988

48 1

54 0

46 0

Density

0.67389804
0.67791373
0.68192941
0.62169412
0.54941176
0.52531765
0.52130196
0.50523922
0.46508235
0.43295686
0.43697255
0.42492549
0.4209098
0.44500392
0.44098824
0.43295686
0.42894118
0.42894118
0.43295686
0.41689412
0.3928
0.41689412
0.44901961
0.44901961
0.44098824
0.44500392
0.46106667
0.41287843
0.39681569
0.42894118
0.38075294
0.3646902
0.43697255
0.43697255
0.36870588
0.38075294
0.40484706
0.37272157

Uncalibrated Calibrated
Density

0.716246
0.720437
0.724627
0.661769
0.586339
0.561195
0.557005
0.540242
0.498337
0.464812
0.469003
0.456431

0.45224
0.477384
0.473193
0.464812
0.460622
0.460622
0.464812

0.44805
0.422906

0.44805
0.481574
0.481574
0.473193
0.477384
0.494146
0.443859
0.427097
0.460622
0.410335
0.393572
0.469003
0.469003
0.397763
0.410335
0.435478
0.401954

0.636663
0.640388
0.644113
0.588239

0.52119

0.49884
0.495115
0.480215
0.442966
0.413166
0.416891
0.405716
0.401991
0.424341
0.420616
0.413166
0.409441
0.409441
0.413166
0.398267
0.375917
0.398267
0.428066
0.428066
0.420616
0.424341
0.439241
0.394542
0.379642
0.409441
0.364742
0.349842
0.416891
0.416891
0.353567
0.364742
0.387092
0.357292

Moisture
Content % 0% MC

125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5

0.578641
0.581716
0.584788
0.538361
0.481652
0.462503
0.459299
0.446449
0.414077
0.387923
0.391205
0.381348
0.378055
0.397758
0.394483
0.387923
0.384637
0.384637
0.387923
0.374759
0.354904
0.374759
0.401029
0.401029
0.394483
0.397758

0.41082
0.371459
0.358222
0.384637
0.344927
0.331572
0.391205
0.391205
0.334917
0.344927
0.364848
0.338257

Density at Density at
12 MC

0.715112
0.719308
0.723504
0.660576
0.585105
0.559958
0.555767
0.539006
0.497113
0.463608
0.467796
0.455234
0.451046
0.476171
0.471984
0.463608
0.459421
0.459421
0.463608
0.446859

0.42174
0.446859
0.480359
0.480359
0.471984
0.476171
0.492924
0.442673
0.425926
0.459421
0.409183
0.392441
0.467796
0.467796
0.396626
0.409183
0.434299
0.400812



46
47
53
62
47
44
61
54
50
66
58
44
54
54
38
39
53
47
29
20
24
45
62
52
34
28
36
53
54
40
32
26
21
24
42
56
51
43
35
27
24
31
48
61
57
42
24
15
22
42
56
46
31
26
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0.37272157
0.37673725
0.40083137
0.43697255
0.37673725
0.3646902
0.43295686
0.40484706
0.38878431
0.45303529
0.4209098
0.3646902
0.40484706
0.40484706
0.34059608
0.34461176
0.40083137
0.37673725
0.3044549
0.26831373
0.28437647
0.36870588
0.43697255
0.39681569
0.32453333
0.30043922
0.33256471
0.40083137
0.40484706
0.34862745
0.31650196
0.29240784
0.27232941
0.28437647
0.35665882
0.41287843
0.3928
0.36067451
0.32854902
0.29642353
0.28437647
0.31248627
0.38075294
0.43295686
0.41689412
0.35665882
0.28437647
0.24823529
0.2763451
0.35665882
0.41287843
0.37272157
0.31248627
0.29240784

Uncalibrated Calibrated
Density

Density
0.401954
0.406144
0.431288
0.469003
0.406144
0.393572
0.464812
0.435478
0.418716
0.485765

0.45224
0.393572
0.435478
0.435478
0.368429

0.37262
0.431288
0.406144
0.330714
0.292999
0.309761
0.397763
0.469003
0.427097
0.351667
0.326523
0.360048
0.431288
0.435478

0.37681
0.343286
0.318142
0.297189
0.309761
0.385191
0.443859
0.422906
0.389382
0.355857
0.322333
0.309761
0.339095
0.410335
0.464812

0.44805
0.385191
0.309761
0.272046

0.30138
0.385191
0.443859
0.401954
0.339095
0.318142

0.357292
0.361017
0.383367
0.416891
0.361017
0.349842
0.413166
0.387092
0.372192
0.431791
0.401991
0.349842
0.387092
0.387092
0.327492
0.331217
0.383367
0.361017
0.293968
0.260443
0.275343
0.353567
0.416891
0.379642
0.312593
0.290243
0.320043
0.383367
0.387092
0.334942
0.305143
0.282793
0.264168
0.275343
0.342392
0.394542
0.375917
0.346117
0.316318
0.286518
0.275343
0.301418
0.364742
0.413166
0.398267
0.342392
0.275343
0.241819
0.267893
0.342392
0.394542
0.357292
0.301418
0.282793

Moisture

Density at

Content % 0% MC

125
125
125
125
12.5
125
12.5
125
125
125
125
125
125
125
12.5
125
12.5
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5

0.338257
0.341594
0.361537
0.391205
0.341594
0.331572
0.387923
0.364848
0.351582
0.404296
0.378055
0.331572
0.364848
0.364848
0.311429
0.314796
0.361537
0.341594

0.28096
0.250181
0.263899
0.334917
0.391205
0.358222
0.297925
0.277555
0.304684
0.361537
0.364848
0.318158

0.29115
0.270735
0.253616
0.263899
0.324873
0.371459
0.354904
0.328225
0.301307
0.274147
0.263899
0.287757
0.344927
0.387923
0.374759
0.324873
0.263899
0.232947
0.257048
0.324873
0.371459
0.338257
0.287757
0.270735

Density at
12 MC

0.400812
0.404997
0.430113
0.467796
0.404997
0.392441
0.463608
0.434299
0.417554
0.484548
0.451046
0.392441
0.434299
0.434299
0.367333
0.371517
0.430113
0.404997
0.32968
0.292039
0.308767
0.396626
0.467796
0.425926
0.350597
0.325497
0.358965
0.430113
0.434299
0.375702
0.34223
0.317132
0.296221
0.308767
0.384071
0.442673
0.42174
0.388256
0.354781
0.321314
0.308767
0.338046
0.409183
0.463608
0.446859
0.384071
0.308767
0.271132
0.300403
0.384071
0.442673
0.400812
0.338046
0.317132



Uncalibrated Calibrated Moisture Density at Density at

Density Density Content % 0% MC 12 MC
23 0 0.28036078 0.30557 0.271618 12.5 0.260475 0.304585
18 0 0.26028235 0.284618 0.252993 12.5 0.243299 0.283676
14 0 0.24421961 0.267855 0.238094 12.5 0.229488 0.266951
14 0 0.24421961 0.267855 0.238094 12.5 0.229488 0.266951
22 1977 0.2763451 0.30138 0.267893 12.5 0.257048 0.300403
40 1 0.34862745 0.37681 0.334942 12.5 0.318158 0.375702
54 0 0.40484706 0.435478 0.387092 12.5 0.364848 0.434299
54 0 0.40484706 0.435478 0.387092 12.5 0.364848 0.434299
52 0 0.39681569 0.427097 0.379642 12.5 0.358222 0.425926
51 0 0.3928 0.422906 0.375917 12.5 0.354904 0.42174
48 0 0.38075294 0.410335 0.364742 12.5 0.344927 0.409183
41 0 0.35264314 0.381001 0.338667 12.5 0.321518 0.379886
32 0 0.31650196 0.343286 0.305143 125 0.29115 0.34223
24 0 0.28437647 0.309761 0.275343 12.5 0.263899 0.308767
19 0 0.26429804 0.288808 0.256718 12.5 0.246742 0.287857
22 0 0.2763451 0.30138 0.267893 12.5 0.257048 0.300403
36 1976 0.33256471 0.360048 0.320043 12.5 0.304684 0.358965
56 1 0.41287843 0.443859 0.394542 12.5 0.371459 0.442673
65 0 0.44901961 0.481574 0.428066 12.5 0.401029 0.480359
62 0 0.43697255 0.469003 0.416891 12.5 0.391205 0.467796
60 0 0.42894118 0.460622 0.409441 12.5 0.384637 0.459421
57 0 0.41689412 0.44805 0.398267 12.5 0.374759 0.446859
48 0 0.38075294 0.410335 0.364742 12.5 0.344927 0.409183
36 0 0.33256471 0.360048 0.320043 12.5 0.304684 0.358965
26 0 0.29240784 0.318142 0.282793 12.5 0.270735 0.317132
19 0 0.26429804 0.288808 0.256718 12.5 0.246742 0.287857
14 0 0.24421961 0.267855 0.238094 12.5 0.229488 0.266951
13 0 0.24020392 0.263665 0.234369 12.5 0.226025 0.26277
19 0 0.26429804 0.288808 0.256718 12.5 0.246742 0.287857
40 1975 0.34862745 0.37681 0.334942 12.5 0.318158 0.375702
68 1 0.46106667 0.494146 0.439241 125 0.41082 0.492924
79 0 0.50523922 0.540242 0.480215 12.5 0.446449 0.539006
73 0 0.4811451 0.515099 0.457866 12.5 0.427068 0.513868
60 0 0.42894118 0.460622 0.409441 12.5 0.384637 0.459421
46 0 0.37272157 0.401954 0.357292 12.5 0.338257 0.400812
37 0 0.33658039 0.364238 0.323768 12.5 0.308059 0.363149
33 0 0.32051765 0.347476 0.308868 12.5 0.294539 0.346413
33 0 0.32051765 0.347476 0.308868 12.5 0.294539 0.346413
33 0 0.32051765 0.347476 0.308868 12.5 0.294539 0.346413
28 0 0.30043922 0.326523 0.290243 12.5 0.277555 0.325497
25 0 0.28839216 0.313952 0.279068 12.5 0.267319 0.312949
37 1974 0.33658039 0.364238 0.323768 12.5 0.308059 0.363149
60 1 0.42894118 0.460622 0.409441 12.5 0.384637 0.459421
66 0 0.45303529 0.485765 0.431791 12.5 0.404296 0.484548
52 0 0.39681569 0.427097 0.379642 12.5 0.358222 0.425926
38 0 0.34059608 0.368429 0.327492 12.5 0.311429 0.367333
28 0 0.30043922 0.326523 0.290243 12.5 0.277555 0.325497
21 0 0.27232941 0.297189 0.264168 12.5 0.253616 0.296221
19 0 0.26429804 0.288808 0.256718 12.5 0.246742 0.287857
19 0 0.26429804 0.288808 0.256718 12.5 0.246742 0.287857
20 0 0.26831373 0.292999 0.260443 12.5 0.250181 0.292039
26 1973 0.29240784 0.318142 0.282793 12,5 0.270735 0.317132
42 1 0.35665882 0.385191 0.342392 12.5 0.324873 0.384071
64 0 0.44500392 0.477384 0.424341 12.5 0.397758 0.476171



66 0
53 0
54 0
60 0
57 0
44 0
38 1972
55 1
72 0
67 0
56 0
51 0
56 1971
78 1
87 0
74 0
52 0
18 0
18 0
Northern Path
SAMPLE 521
THICKNESS mm 1
SLITLENGTH mm 2
SLITWIDTH mm 0.878893
HPIXELSIZE mm  0.878893
VPIXELSIZE mm  0.878893
DATA
DENSITY YEAR
0 0
1 0
5 0
16 0
49 0
97 0
121 0
117 0
97 0
62 0
56 0
89 0
101 2002
87 2001
72 0
66 2000
67 0
61 1999
51 1
54 1998

Uncalibrated
Density

0.45303529
0.40083137
0.40484706
0.42894118
0.41689412
0.3646902
0.34059608
0.40886275
0.47712941
0.45705098
0.41287843
0.3928
0.41287843
0.50122353
0.53736471
0.48516078
0.39681569
0.26028235
0.26028235

0.59358431
0.53736471
0.47712941
0.45303529
0.45705098
0.43295686

0.3928
0.40484706

Calibrated
Density

0.485765
0.431288
0.435478
0.460622
0.44805
0.393572
0.368429
0.439669
0.510908
0.489956
0.443859
0.422906
0.443859
0.536052
0.573767
0.51929
0.427097
0.284618
0.284618

0.632435
0.573767
0.510908
0.485765
0.489956
0.464812
0.422906
0.435478

0.431791
0.383367
0.387092
0.409441
0.398267
0.349842
0.327492
0.390817
0.454141
0.435516
0.394542
0.375917
0.394542
0.476491
0.510015
0.461591
0.379642
0.252993
0.252993

0.562164
0.510015
0.454141
0.431791
0.435516
0.413166
0.375917
0.387092

Moisture Density at
Content % 0% MC
12.5 0.404296
12,5 0.361537
12.5 0.364848
12.5 0.384637
12.5 0.374759
12,5 0.331572
12,5 0.311429
12.5 0.368155
12.5 0.423826
125 0.40756
12,5 0.371459
12.5 0.354904
12,5 0.371459
12.5 0.443227
12.5 0.472093
12.5 0.430307
12.5 0.358222
12.5 0.243299
12.5 0.243299

125
125
125
125
125
125
125
125

0.516438
0.472093
0.423826
0.404296

0.40756
0.387923
0.354904
0.364848

Density at
12 MC

0.484548
0.430113
0.434299
0.459421
0.446859
0.392441
0.367333
0.438486
0.509679
0.488736
0.442673
0.42174
0.442673
0.534816
0.572531
0.518058
0.425926
0.283676
0.283676

0.631221
0.572531
0.509679
0.484548
0.488736
0.463608

0.42174
0.434299



63
64
62
62
61
63
65
60
61
73
72
66
66
68
65
53
55
58
58
64
56
43
44
46
43
43
52
56
45
47
56
47
44
60
58
41
51
64
48
32
43
60
51
29
18
25
49
63
51
34
25
32
58
66

0.44098824
0.44500392
0.43697255
0.43697255
0.43295686
0.44098824
0.44901961
0.42894118
0.43295686
0.4811451
0.47712941
0.45303529
0.45303529
0.46106667
0.44901961
0.40083137
0.40886275
0.4209098
0.4209098
0.44500392
0.41287843
0.36067451
0.3646902
0.37272157
0.36067451
0.36067451
0.39681569
0.41287843
0.36870588
0.37673725
0.41287843
0.37673725
0.3646902
0.42894118
0.4209098
0.35264314
0.3928
0.44500392
0.38075294
0.31650196
0.36067451
0.42894118
0.3928
0.3044549
0.26028235
0.28839216
0.38476863
0.44098824
0.3928
0.32453333
0.28839216
0.31650196
0.4209098
0.45303529

Uncalibrated Calibrated
Density

Density
0.473193
0.477384
0.469003
0.469003
0.464812
0.473193
0.481574
0.460622
0.464812
0.515099
0.510908
0.485765
0.485765
0.494146
0.481574
0.431288
0.439669

0.45224

0.45224
0.477384
0.443859
0.389382
0.393572
0.401954
0.389382
0.389382
0.427097
0.443859
0.397763
0.406144
0.443859
0.406144
0.393572
0.460622

0.45224
0.381001
0.422906
0.477384
0.410335
0.343286
0.389382
0.460622
0.422906
0.330714
0.284618
0.313952
0.414525
0.473193
0.422906
0.351667
0.313952
0.343286

0.45224
0.485765

0.420616
0.424341
0.416891
0.416891
0.413166
0.420616
0.428066
0.409441
0.413166
0.457866
0.454141
0.431791
0.431791
0.439241
0.428066
0.383367
0.390817
0.401991
0.401991
0.424341
0.394542
0.346117
0.349842
0.357292
0.346117
0.346117
0.379642
0.394542
0.353567
0.361017
0.394542
0.361017
0.349842
0.409441
0.401991
0.338667
0.375917
0.424341
0.364742
0.305143
0.346117
0.409441
0.375917
0.293968
0.252993
0.279068
0.368467
0.420616
0.375917
0.312593
0.279068
0.305143
0.401991
0.431791

Moisture

Density at

Content % 0% MC

125
125
125
125
12.5
125
12.5
125
12.5
125
125
125
125
125
12.5
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5
125
12.5

0.394483
0.397758
0.391205
0.391205
0.387923
0.394483
0.401029
0.384637
0.387923
0.427068
0.423826
0.404296
0.404296

0.41082
0.401029
0.361537
0.368155
0.378055
0.378055
0.397758
0.371459
0.328225
0.331572
0.338257
0.328225
0.328225
0.358222
0.371459
0.334917
0.341594
0.371459
0.341594
0.331572
0.384637
0.378055
0.321518
0.354904
0.397758
0.344927

0.29115
0.328225
0.384637
0.354904

0.28096
0.243299
0.267319
0.348256
0.394483
0.354904
0.297925
0.267319

0.29115
0.378055
0.404296

Density at
12 MC

0.471984
0.476171
0.467796
0.467796
0.463608
0.471984
0.480359
0.459421
0.463608
0.513868
0.509679
0.484548
0.484548
0.492924
0.480359
0.430113
0.438486
0.451046
0.451046
0.476171
0.442673
0.388256
0.392441
0.400812
0.388256
0.388256
0.425926
0.442673
0.396626
0.404997
0.442673
0.404997
0.392441
0.459421
0.451046
0.379886
0.42174
0.476171
0.409183
0.34223
0.388256
0.459421
0.42174
0.32968
0.283676
0.312949
0.413368
0.471984
0.42174
0.350597
0.312949
0.34223
0.451046
0.484548



Uncalibrated Calibrated Moisture Density at Density at

Density Density Content % 0% MC 12 MC
47 0 0.37673725 0.406144 0.361017 12.5 0.341594 0.404997
32 0 0.31650196 0.343286 0.305143 125 0.29115 0.34223
24 0 0.28437647 0.309761 0.275343 12.5 0.263899 0.308767
24 1980 0.28437647 0.309761 0.275343 12.5 0.263899 0.308767
38 1 0.34059608 0.368429 0.327492 12.5 0.311429 0.367333
49 0 0.38476863 0.414525 0.368467 12.5 0.348256 0.413368
44 0 0.3646902 0.393572 0.349842 12.5 0.331572 0.392441
32 0 0.31650196 0.343286 0.305143 125 0.29115 0.34223
24 0 0.28437647 0.309761 0.275343 12.5 0.263899 0.308767
23 0 0.28036078 0.30557 0.271618 12.5 0.260475 0.304585
27 0 0.29642353 0.322333 0.286518 12.5 0.274147 0.321314
41 1979 0.35264314 0.381001 0.338667 12.5 0.321518 0.379886
54 0 0.40484706 0.435478 0.387092 12.5 0.364848 0.434299
53 0 0.40083137 0.431288 0.383367 12.5 0.361537 0.430113
42 0 0.35665882 0.385191 0.342392 12.5 0.324873 0.384071
28 0 0.30043922 0.326523 0.290243 12.5 0.277555 0.325497
20 0 0.26831373 0.292999 0.260443 12.5 0.250181 0.292039
22 0 0.2763451 0.30138 0.267893 12.5 0.257048 0.300403
32 0 0.31650196 0.343286 0.305143 125 0.29115 0.34223
53 1978 0.40083137 0.431288 0.383367 12.5 0.361537 0.430113
57 0 0.41689412 0.44805 0.398267 12.5 0.374759 0.446859
38 0 0.34059608 0.368429 0.327492 12.5 0.311429 0.367333
24 0 0.28437647 0.309761 0.275343 12.5 0.263899 0.308767
21 0 0.27232941 0.297189 0.264168 12.5 0.253616 0.296221
20 0 0.26831373 0.292999 0.260443 12.5 0.250181 0.292039
18 0 0.26028235 0.284618 0.252993 12.5 0.243299 0.283676
16 0 0.25225098 0.276237 0.245544 12.5 0.236401 0.275313
19 1977 0.26429804 0.288808 0.256718 12.5 0.246742 0.287857
32 1 0.31650196 0.343286 0.305143 125 0.29115 0.34223
47 0 0.37673725 0.406144 0.361017 12.5 0.341594 0.404997
43 0 0.36067451 0.389382 0.346117 12.5 0.328225 0.388256
31 0 0.31248627 0.339095 0.301418 12.5 0.287757 0.338046
27 0 0.29642353 0.322333 0.286518 12.5 0.274147 0.321314
26 0 0.29240784 0.318142 0.282793 12,5 0.270735 0.317132
21 0 0.27232941 0.297189 0.264168 12.5 0.253616 0.296221
18 0 0.26028235 0.284618 0.252993 12.5 0.243299 0.283676
17 0 0.25626667 0.280427 0.249269 12.5 0.239852 0.279494
17 0 0.25626667 0.280427 0.249269 12.5 0.239852 0.279494
23 0 0.28036078 0.30557 0.271618 12.5 0.260475 0.304585
42 1976 0.35665882 0.385191 0.342392 12.5 0.324873 0.384071
58 0 0.4209098 0.45224 0.401991 12.5 0.378055 0.451046
54 0 0.40484706 0.435478 0.387092 12.5 0.364848 0.434299
43 0 0.36067451 0.389382 0.346117 12.5 0.328225 0.388256
37 0 0.33658039 0.364238 0.323768 12.5 0.308059 0.363149
29 0 0.3044549 0.330714 0.293968 125 0.28096 0.32968
21 0 0.27232941 0.297189 0.264168 12.5 0.253616 0.296221
17 0 0.25626667 0.280427 0.249269 12.5 0.239852 0.279494
15 0 0.24823529 0.272046 0.241819 12.5 0.232947 0.271132
13 0 0.24020392 0.263665 0.234369 12.5 0.226025 0.26277
18 1975 0.26028235 0.284618 0.252993 12.5 0.243299 0.283676
38 1 0.34059608 0.368429 0.327492 12.5 0.311429 0.367333
59 0 0.42492549 0.456431 0.405716 12.5 0.381348 0.455234
61 0 0.43295686 0.464812 0.413166 12.5 0.387923 0.463608
54 0 0.40484706 0.435478 0.387092 12.5 0.364848 0.434299
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Uncalibrated Calibrated
Density Density
0.3646902 0.393572
0.32051765 0.347476
0.3044549 0.330714
0.32051765 0.347476
0.32453333 0.351667
0.31248627 0.339095
0.3646902 0.393572
0.4811451 0.515099
0.50122353 0.536052
0.43295686 0.464812
0.3646902 0.393572
0.31650196 0.343286
0.3044549 0.330714
0.31248627 0.339095
0.33658039 0.364238
0.42492549 0.456431
0.49720784 0.531861
0.46106667 0.494146
0.43295686 0.464812
0.45705098 0.489956
0.44901961 0.481574
0.42492549 0.456431
0.48917647 0.52348
0.55342745 0.590529
0.52933333 0.565386
0.5092549 0.544433
0.54138039 0.577958
0.60964706 0.649197
0.58555294 0.624054
0.41689412 0.44805
0.24823529 0.272046
0.24823529 0.272046

Mean Mean
Uncalibrated Calibrated
Density Density

0.37984203 0.40712
Mean Mean
Uncalibrated Calibrated
Density Density

of the last of the last
23 pixels 23 pixels

0.48795431 0.522205

0.45513043 0.487951

0.349842
0.308868
0.293968
0.308868
0.312593
0.301418
0.349842
0.457866
0.476491
0.413166
0.349842
0.305143
0.293968
0.301418
0.323768
0.405716
0.472766
0.439241
0.413166
0.435516
0.428066
0.405716
0.465316
0.524915
0.502565

0.48394

0.51374
0.577064
0.554714
0.398267
0.241819
0.241819

Moisture
Content %
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5
12.5

Density at
0% MC

0.331572
0.294539
0.28096
0.294539
0.297925
0.287757
0.331572
0.427068
0.443227
0.387923
0.331572
0.29115
0.28096
0.287757
0.308059
0.381348
0.440003
0.41082
0.387923
0.40756
0.401029
0.381348
0.433543
0.484832
0.465703
0.449667
0.475283
0.528986
0.510144
0.374759
0.232947
0.232947

Density at
12 MC

0.392441
0.346413
0.32968
0.346413
0.350597
0.338046
0.392441
0.513868
0.534816
0.463608
0.392441
0.34223
0.32968
0.338046
0.363149
0.455234
0.530626
0.492924
0.463608
0.488736
0.480359
0.455234
0.522247
0.589297
0.564149
0.543196
0.576722
0.647995
0.622835
0.446859
0.271132
0.271132

Mean
Density at
12 MC

Mean
Density at
0% MC
0.341636 0.406
Mean Mean
Density at Density at
0% MC 12 MC

of the last of the last
23 pixels 23 pixels

0.431688 0.521007

0.40582 0.48674



Uncalibrated Calibrated Moisture Density at Density at
Density Density Content % 0% MC 12 MC
Combined 0.47154237 0.505078 0.418754 0.503873
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